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1 About This Manual
This manual enables safe and efficient handling of the device.
This manual is an integral part of the device, and must be kept in close proximity to the
device where it is permanently accessible to personnel. In addition, instructions concerning
labor protection laws, operator regulations tools and supplies must be available and adhered
to.
Before starting any work, personnel must read the manual thoroughly and understand
its contents. Compliance with all specified safety and operating instructions, as well as local
work safety regulations, are vital to ensure safe operation.
The figures shown in this manual are designed to be general and informative and may not
represent the specific Bruker model, component or software/firmware version you are
working with. Options and accessories may or may not be illustrated in each figure.

1.1 Policy Statement
It is the policy of Bruker to improve products as new techniques and components become
available. Bruker reserves the right to change specifications at any time.
Every effort has been made to avoid errors in text and figure presentation in this publication.
In order to produce useful and appropriate documentation, we welcome your comments on
this publication. Support engineers are advised to regularly check with Bruker for updated
information.
Bruker is committed to providing customers with inventive, high quality products and services
that are environmentally sound.

1.2 Symbols and Conventions
Safety instructions in this manual are marked with symbols. The safety instructions are
introduced using indicative words which express the extent of the hazard.
In order to avoid accidents, personal injury or damage to property, always observe safety
instructions and proceed with care.

 DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.
This is the consequence of not following the warning.
1. This is the safety condition.
u This is the safety instruction.
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 WARNING
WARNING indicates a hazardous situation, which, if not avoided, could result
in death or serious injury.
This is the consequence of not following the warning.
1. This is the safety condition.
u This is the safety instruction.

 CAUTION
CAUTION indicates a hazardous situation, which, if not avoided, may result in
minor or moderate injury or severe material or property damage.
This is the consequence of not following the warning.
1. This is the safety condition.
u This is the safety instruction.

NOTICE
NOTICE indicates a property damage message.
This is the consequence of not following the notice.
1. This is a safety condition.
u This is a safety instruction.

SAFETY INSTRUCTIONS
SAFETY INSTRUCTIONS are used for control flow and shutdowns in the event
of an error or emergency.
This is the consequence of not following the safety instructions.
1. This is a safety condition.
u This is a safety instruction.

This symbol highlights useful tips and recommendations as well as
information designed to ensure efficient and smooth operation.
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2 Safety
This manual contains notices which should be observed to ensure your own personal safety
as well as to protect the spectrometer and the connected equipment.

2.1 Intended Use
The minispec mq20 Toothpaste Analyzer is a pulsed time-domain NMR analyzer used for the
monitoring of the fluorine nuclei.
This product is intended to be used solely for measurements on industrial samples.

2.2 Qualified Personnel
The minispec may only be set up and operated in conjunction with the instructions in this
manual. Only qualified personnel should be allowed to work on this equipment. The primary
installation, maintenance and repair of the minispec may only be carried out by personnel
which are authorized by BRUKER.
All repairs, adjustments and alignments performed on any components of the minispec must
be carried out strictly in accordance with the established safety practices and standards of
the country where the instrument is installed.

2.3 Correct Usage
This device and its components may only be used in the way discussed with a BRUKER
specialist and in connection with devices or components from other manufacturers which
have been approved or recommended by BRUKER.

Note: This product can only function correctly and safely if it is transported, stored, set up
and installed correctly, and operated and maintained as recommended by BRUKER.
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2.4 Electrical Safety
There is no danger of electrical shock during routine operation of the spectrometer, however
the following precautions must be followed to assure user safety and protection of the
instrument.

 WARNING
Electrical hazard from electrical shock
A life threatening shock may result when maintenance is performed.
u Place the mains power switch in the OFF position (direction labeled "0" on the switch).
u Disconnect the device from the electrical power supply before maintenance. Use a

voltmeter to verify that the device is not under power!
u Be sure that the power supply cannot be reconnected without notice.
u Ensure that all warning labels are in place.
u Only trained personnel should carry out maintenance.

The safety precautions applicable to any electronic device connected to AC power must be
observed.
Always use the power cable that is delivered with the product.
If replacement of the power cable is necessary, make sure that the ratings with regard to the
power consumption of the device are suitable.

 WARNING
Electrical hazard from stored electrical charge
A life threatening shock or material damage may result from a stored electrical charge.
Never touch electrical contacts or semiconductor chips with any object (conductive or non-
conductive) unless all of the following conditions are met:
u The power switch is off.
u The power plug is disconnected from either the power socket or the main power socket

on the spectrometer.
u The conductive object and you are grounded.
ð This precaution prevents the possibility of electrical shock from stored charge within the

power supply circuitry or the transfer of static charge that can damage semiconductor
chips.

Note: No other components within the spectrometer should be touched (even with the power
off) without first contacting a Bruker service representative to obtain all necessary
instructions, to ensure user and spectrometer safety.
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2.5 Lifting Safety
The magnet unit weighs about 85 kg, to ensure safety the follow safety instructions must be
followed:

 CAUTION
Risk of injury from lifting heavy objects.
The unit is very heavy and may lead to injury when lifting.
u Do not attempt to lift the unit over the edge of the carton, remove the carton first.
u Do not attempt to lift the unit on your own or without necessary precaution against

injury.
u Use a hoist if available.
u Follow the step-by-step instructions in the installation section of this manual.

2.6 Personal Safety

2.6.1 Safety for Persons Wearing Pacemakers

The instrument contains strong magnetic fields, some of which extend beyond the magnet
unit house (see stray field diagram below). These pose no danger to routine users, but are
hazardous to persons with heart pacemakers or other medical implantations.

 WARNING
Danger to life from strong magnetic fields!
Strong magnetic fields may cause serious injuries or death and significant damage to
property.
u Persons fitted with heart pacemakers must be kept away from the device. The

functionality of the heart pacemaker could be compromised.
u Persons with metal implants must be kept away from the device. Implants may heat up

or be subject to magnetic attraction.
u Ferromagnetic materials, tools, and electromagnets must be kept away from the

magnetic source. Such materials could be subject to magnetic attraction and may fly
around the room, injuring or killing people. Minimum distance 3 meters.

u Remove magnetic items (jewelry, watches, pens etc.) before carrying out maintenance
work.

u Keep electronic equipment away from the magnetic source. Such equipment could be
damaged.

u Keep storage media, credit cards etc. away from the magnetic source. Data could be
erased.
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Figure 2.1: Magnet Stray Field Plot

For the mq20 Toothpaste Analyzer the following distances of the 5 Gauss line from the
housing of the system apply (refer to figure above):

• System front and back panels: 5 Gauss line goes 5 cm out of the box.
• Upper and lower surfaces: 5 Gauss line goes 25 cm out of the box.
• Lateral plates: 5 Gauss line goes 25 cm out of the box.
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2.6.2 Safety When Working with Glassware

 WARNING
Danger of injury from glassware or ceramics breakage!
Broken glassware or ceramics may cause minor injuries or material damage, but may also
result in a life threatening situation if hazardous substances are used.
u If glassware or ceramics breaks, refer to the corresponding precautions and cleaning/

disinfection instructions.
u Wear protective equipment.
u Perform all tasks with the glassware or ceramics carefully.
u Before carrying out any maintenance work, remove the samples and use dummy

samples if necessary.
u Strictly observe the correct sample adjustment, i.e. the maximum sample height.
u Always transport the glassware or ceramics with the cover, if applicable. Never turn the

glassware or ceramics upside down or on it’s side.
u The laboratory supervisor is responsible for:

ð Establishing and enforcing standard sample handling and cleaning procedures.

ð Establishing and enforcing the use of protective clothing and equipment.

ð Training laboratory personnel.

ð Preparing an emergency plan.
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3 Transport, Packaging and
Storage

Installation, initial commissioning, retrofitting, repairs, adjustments or dismantling of the
device must only be carried out by Bruker Service or personnel authorized by Bruker.
Damage due to servicing that is not authorized by Bruker is not covered by your warranty.

3.1 Symbols on the Packaging
The following symbols are affixed to the packaging material. Always observe the symbols
during transport and handling.

Top The arrow tips on the sign mark the top of the
package. They must always point upwards;
otherwise the content may be damaged.

Fragile Marks packages with fragile or sensitive
contents.
Handle the package with care; do not allow the
package to fall and do not allow it to be
impacted.

Protect Against Moisture Protect packages against moisture and keep
dry.

Attach Here Lifting gear (lifting chain, lifting strap) must
only be attached to points bearing this symbol.

Center of Gravity Marks the center of gravity of packages.
Note the location of the center of gravity when
lifting and transporting.

Weight, Attached Load Indicates the weight of packages.
Handle the marked package in accordance
with its weight.

Permitted Stacking Load Indicates packages which are partially
stackable.
Do not exceed the maximum load-bearing
capacity specified on the symbol in order to
avoid damaging or destroying the content.
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Do not Damage Air-tight
Packaging

The packaging is air-tight. Damage to the
barrier layer may render the contents
unusable.
Do not pierce.
Do not use sharp objects to open.

Component Sensitive to
Electrostatic Charge

The packaging contains components which
are sensitive to an electrostatic charge.
Only allow packaging to be opened by trained
personnel.
Establish potential equalisation before
opening.

Protect from Heat Protect packages against heat and direct
sunlight.

Protect from Heat and
Radioactive Sources

Protect packages against heat, direct sunlight
and radioactive sources.

Table 3.1: Symbols on the Packaging

3.2 Inspection at Delivery
Upon receipt, immediately inspect the delivery for completeness and transport damage.
Proceed as follows in the event of externally apparent transport damage:

• Do not accept the delivery, or only accept it subject to reservation.
• Note the extent of the damage on the transport documentation or the shipper's delivery

note.
• Initiate complaint procedures.

Note: Issue a complaint in respect to each defect immediately following detection. Damage
compensation claims can only be asserted within the applicable complaint deadlines.
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3.3 Packaging

About Packaging
The individual packages are packaged in accordance with anticipated transport conditions.
Only environmentally friendly materials have been used in the packaging.
The packaging is intended to protect the individual components from transport damage,
corrosion and other damage prior to assembly. Therefore do not destroy the packaging and
only remove it shortly before assembly.
It is recommended to store the packaging for later use in the event that you need to return the
unit to Bruker.

Handling Packaging Materials
Dispose of packaging material in accordance with the relevant applicable legal requirements
and local regulations (see Dismantling and Disposal [} 77]).

3.4 Storage

Storage of the Packages
Store the packages under the following conditions:

• Do not store outdoors.
• Store in dry and dust-free conditions.
• Do not expose to aggressive media.
• Protect against direct sunlight.
• Avoid mechanical shocks.
• Storage temperature: 15 to 35 °C.
• Relative humidity: max. 60%.
• If stored for longer than 3 months, regularly check the general condition of all parts and

the packaging. If necessary, top-up or replace preservatives.

Note: Under certain circumstances, storage instructions may be affixed to packages which
expand the requirements specified here. Comply with these accordingly.
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4 Technical Data

4.1 General Information

No. Series Type Weight
(kg)

Length
(cm)

Width
(cm)

Heigth
(cm)

1 mq20 Toothpaste
Analyzer

105 65 75 33

Table 4.1: Technical Data: General Information

All specifications above are without a PC. Weights and dimensions apply to the instruments,
not to the packaged systems.

4.2 Connection Values
Grounding is vital for the safe operation of the instrument. Never operate with the grounding
conductor disconnected. If the local wiring does not provide a ground, an earth-to-chassis
connection must be added at the user’s location.

Note: Since the input voltage may be unstable in a laboratory environment, it is
recommended to connect the minispec to a separate circuit that is not used by any other
equipment. Furthermore, a voltage stabilizer or UPS may be required to avoid instrument
instabilities or other unexpected system behavior caused by a fluctuating input voltage.

No. Series Type ND/NE/NF Voltage/VAC Apparent
Power
Consumption,
Maximum/VA

Circuit
Protection
(Two
indications:
NF/ND Series)

Freque
ncy/Hz

1 mq20 Toothpaste
Analyzer

NF 100-240 300/250 3.15/2.5 AT (2
pieces)

50-60

Table 4.2: Electrical Connection Values
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4.3 Operating Conditions

Environment

No. Series Type Temperature
Range,
Maximum/°C

Temperature
Range, Ideal/
°C

Relative
Humidity at
31 °C,
Maximum/%

Decreasing
Linear Till
Relative
Humidity <
50% at 40°C,
maximum/%

IP
Safety
Class

1 mq20 Toothpaste
Analyzer

18-28 22-25 80 (non-
condensing)

< 50% IP20

Table 4.3: Operating Environment

NormaI environmental conditions (CAN/CSA 61010-1-12; IEC 61010-1: 2010; ANSI/UL 61010-1)
• Indoor use only.
• Maximum operation altitude: 2000 m.
• Ideal operating temperature: 22-25 °C. Minimum operating temperature: 18°C Maximum

operating temperature: 28°C Humidity (non-condensing): 20-80%
• Maximum relative humidity 80% for temperatures up to 31 or decreasing linearly to 50%

relative humidity at 40 °C.
• MAINS supply voltage fluctuations up to ±10% of the nominal voltage.
• TRANSIENT OVERVOLTAGES up to the levels of OVERVOLTAGE CATEGORY II.
• Pollution degree 2.
• Protection class IP20.

4.4 minispec Software CD

Description Manual Bruker Part
Number

minispec Software CD-ROM
(Windows 7/Office 2013).

The minispec Pre-Installation manual
is available as a PDF document on
the CD-ROM/memory stick.

E1405378

Table 4.4: Bruker minispec Software-CD
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4.5 Specifications mq20 Toothpaste Analyzer

4.5.1 Weights and Dimensions

Electronic Control Unit Magnet Unit

Dimensions (W x H x D) in cm 23 x 31 x 60 47 x 31 x 60

Weight (kg) 20 85

Table 4.5: Weights and Dimensions for mq20 Toothpaste Analyzer

4.5.2 Electrical Specifications

minispec mq-Series systems (wideline versions / see corresponding label on back of the unit):
The instruments (wideline) are specified for the following mains voltages:
Input Voltage Range: 100 – 240 V AC 50/60 Hz
Fuse rating mq-Series NF: 2 x 3.15 AT

All Systems
Grounding is vital for the safe operation of the instrument. Never operate with the grounding
conductor disconnected. If the local wiring does not provide a ground, an earth-to-chassis
connection must be added at the user’s location.

Note: Since the input voltage may be unstable in a laboratory environment, it is
recommended to connect the minispec to a separate circuit that is not used by any other
equipment. Furthermore, a voltage stabilizer or UPS may be required to avoid instrument
instabilities or other unexpected system behavior caused by a fluctuating input voltage.

4.6 Rating Plate
The rating plate is located at the power input and includes the following information:

Figure 4.1: The minispec MQ-Series Rating Plate
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5 Introduction
The minispec mq20 Toothpaste Analyzer is a benchtop Nuclear Magnetic Resonance (NMR)
analyzer for detection of fluorine (19F).
This manual provides instructions on proper installation of the minispec and an introduction to
the use of the minispec hardware and software. Topics covered include:

• Installation of hardware (section Installation of the minispec mq-Series).
• Installation of software for WindowsTM 7 32-bit/64-bit if needed (section Software

Installation [} 31]).
• Software configuration, if needed. Analyzers typically are equipped with PC systems and

pre-installed software.
• Proper operation of the system by using minispec Plus software, the GUI for the mq20

Toothpaste Analyzer (calibration, measurement, result, administration, etc.).
• Using minispec.exe software, the minispec software used for diagnostic and service

purposes.
• The software functions are discussed step by step, using pictures to help familiarize the

user with all of the accessible minispec features.
• Finally, for a better understanding of the principles involved, an introduction to the basics

of NMR is provided in the section Basic NMR Principles [} 73].

Figure 5.1: The minispec mq20 Toothpaste Analyzer

The minispec software package minispec Plus is the main software running on the mq20
Toothpaste Analyzer systems and is described in this manual. Software operation is
explained in detail in the following manuals, which are available on the minispec software CD/
memory stick:

• minispec Plus Administration
• minispec Plus Classic
• minispec Plus Chemometrics
• minispec Plus NoCalibration
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5.1 Siting Considerations
Place the units on a strong, level, non-magnetic benchtop surface, capable of supporting their
weight (refer to Weights and Dimensions). A minimum distance of 10 cm should be allowed
between the back of the Electronic Control Unit and adjacent objects in order to ensure
sufficient air-cooling.
Since objects containing iron can influence the magnetic field inside the Magnet Unit, do not
locate the Magnet Unit within 1  m of large iron objects or within 2  m of moving metallic
objects.

 CAUTION
Accident or material damage hazard from falling or tilting instrument
Instrument may fall down or tilt during installation, retrofitting, dismantling, or while moving
on a cart.
u Use the carrying handles during lifting.
u When a table or cart is used, it should meet the requirements in the pre-installation

manual.
u The instrument should be secured to the cart or table.

5.1.1 Environmental Considerations

The minispec should be used in areas free from direct sunlight, heat sources and power
cables.
A constant temperature is important for field stability and accurate reproduction of
measurement results.
The usual magnet temperature (if not indicated different) is 40°C for all instruments.
These temperatures have been selected because they are well above the expected ambient
(laboratory) temperatures and therefore allow accurate tempering of the minispec unit.
Tempering of the magnet and the console electronics is accomplished with a closed cycle
zero maintenance, air ventilation system, so that no external air is ventilated through the
console or the Analyzer Unit.
In some factory environments where dust may be a problem, it may be desirable to house the
minispec computer in a clean room or ventilated housing, which is protected from dust. The
Analyzer Unit can be placed nearby at a location more convenient for process personnel.
The instrument contains strong magnetic fields, some of which extend beyond the Analyzer
unit housing (see stray field diagram page 14-17). These pose no danger to routine users,
but are hazardous to persons with heart pacemakers or other medical implantations.
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 WARNING
Risk to life due to high magnetic fields
A magnetic field of more than 0.5 mT (5 Gauss) is life-threatening for people with
pacemakers or active metal implants. Exposure to more than 8 T can cause damage to
health. Duration of exposure (8 h/day) above the limit of 200 mT can cause damage to
health. Ferromagnetic tools in the magnetic field are significantly hazardous. Disks and
electronic devices may be damaged.
u Mark the magnetic field of more than 0.5 mT (5 Gauss) before start up.
u Keep people with active medical implants or heart pacemakers away from the 0.5 mT

(5 Gauss) area.
u The permanent workplace of employees must be outside the 0.5 mT (5 Gauss) area.
u Do not stay or work at magnetic fields of more than 8 T.
u Prevent exposure of more than 200 mT for more than 8 h/day.
u Keep disks, credit cards and electronic devices away from the identified area.
u Do not use ferromagnetic tools or items within the identified area.
u Only use non-ferromagnetic transportation dewars or pressure cylinders for the

cryogenic agents.
u Only use non-ferromagnetic ladders or steps.
u Remove magnetic items (jewelry, watches, pens etc.) before carrying out maintenance

work.

 WARNING
Danger of injury or material damage due to strong magnetic fields!
Injury or material damage may result due to the strong magnetic fields that can draw metallic
objects towards the magnet.
u DO NOT locate the instrument next to large iron-containing objects or near moving

metallic objects.
u DO NOT place any iron-containing object on the minispec magnet unit. Be aware that

the magnetic field can erase magnetic recording media such as computer diskettes or
credit cards.

u DO NOT place these items or clothing containing these items on the magnet unit.
u Leave the dust cover on the probe canal when the instrument is not in use.
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5.2 Installation of the minispec mq20 Toothpaste Analyzer
The minispec mq-Series consists of 2 units plus a control PC:

• Magnet Unit, containing the magnet system and the probe assembly
• Electronic Control Unit with the NMR electronics
• Standard PC user interface for measurement control, data processing, etc.

Figure 5.2: The minispec Magnet Unit (left) and Electronic Control Unit (right).

A number of optional accessories can be added and adapted for use: electronic balances,
auto sampler, temperature control baths and variable temperature control units, etc.

5.2.1 Unpacking the System

When unpacking the instrument ensure that all components listed in the packing list are part
of the delivery.

 CAUTION
Danger of property damage due to improper handling.
The shipping container must remain in an upright position at all times. It has two
compartments separated by a wooden plate: an upper part, which contains the Electronic
Control Unit, and a lower part containing the Magnet Unit. The magnet unit is secured to the
shipping container from below with four bolts.
u DO NOT tilt the container when removing these bolts.

 CAUTION
Accident or material damage hazard from falling or tilting instrument
Instrument may fall down or tilt during installation, retrofitting, dismantling, or while moving
on a cart.
u Use the carrying handles during lifting.
u When a table or cart is used, it should meet the requirements in the pre-installation

manual.
u The instrument should be secured to the cart or table.
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 CAUTION
Risk of injury from lifting heavy objects.
The unit is very heavy and may lead to injury when lifting.
u Do not attempt to lift the unit over the edge of the carton, remove the carton first.
u Do not attempt to lift the unit on your own or without necessary precaution against

injury.
u Use a hoist if available.
u Follow the step-by-step instructions in the installation section of this manual.

To unpack the system:
1. Use a 13 mm wrench to remove the four bolts from the bottom of the container.
2. Remove the shipping straps and open the container.
3. Remove the packing material from around the Electronic Control Unit.
4. Remove the Electronic Control Unit from the container, together with the wooden plate

that it is mounted on (do not tip!). Remove the four mounting bolts from below the plate
using a 13 mm wrench. Once loose, remove the Electronic Control Unit and set it in a safe
location.

5. Remove the packing material from around the Magnet Unit. Remove the retaining screws
or nails from the bottom of the wooden pallet and detach the shipping carton.

6. While keeping it level, carefully lift the Magnet Unit from the pallet using the handles on
either side, and place it on a sturdy cart or benchtop.

When using a hoist, make sure the straps are capable of carrying the magnet´s weight and
are attached in such a way that the magnet cannot fall, slip, topple or turn while being
carried.

7. Once the magnet has been placed in it’s desired position, the handles can be retracted.
While keeping the handles pressed down, push them below the case (see figure, arrows 1
and 2).

Figure 5.3: Handles on the Side of the Magnet Unit
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8. Remove and retain the clear plastic dust covers from each component of the minispec and
inspect them for damage.

9. If either unit appears to be damaged, contact your BRUKER representative immediately.
Due to accessories, consumables or optional units packaging may vary. Bruker will make
every effort to deliver the instrument damage free. Therefore, packaging needs to be adapted
to the specific customer order. Due to safety regulations, the system may be packed with
additional shielding elements or may be declared as dangerous goods.

5.2.2 Electronic Control and the Magnet Unit Connections

The connectors are located on the bottom of the back planes. Connect the two units as
shown in the figures below:

Figure 5.4: Electronic Control and Magnet Units

1. Main power input. 3 to 5. Connections to the units.
2. Ethernet connection.

Here is an expanded view of the connections:

Figure 5.5: Back Planes of the Electronic Control Unit (top) and Magnet Unit (bottom)

1. Mains Power Input 4. Interface to Gradient Unit
2. Ethernet (10 Base T) Connection 5. Interface to Electronic Control Unit
3. Interface to Magnet Unit 6. Interface to Gradient Unit
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5.3 Interpretation of the LEDs
Users receive continuous indication of the status of the different units in the form of light
emitting diodes (LEDs), which are built into the front panel of the units.

5.3.1 LEDs for the mq20 Toothpaste Analyzer

Electronic Control Unit
Right LED, connection status indicator:

• ON (green): PC communication to the Electronic Control Unit is OK.
• OFF: No communication between the Electronic Control Unit and the PC.

Left LED, status indicator:
• ON (green): The Electronic Control Unit is working.
• OFF: The Electronic Control Unit is not working.

Magnet Unit
Right LED, indicates the magnet temperature status:

• RED: Pre-heating.
• YELLOW: Transition to normal heating.
• GREEN: Temperature is OK.

Left LED, connection status indicator:
• ON (green): Communication between the Electronic Control Unit and Magnet Unit is OK.
• OFF: No communication between the Electronic Unit and Magnet Unit.

5.4 Calibration Samples Hatch and Probe Exchange
The Magnet Unit cover has two outer hatches or doors.

• The first one is on the front panel of the unit and can be used to contain the calibration
samples. Pressing on the upper part of the hatch will unlock and open it.

• The second is the top hatch, which allows access into the minispec magnet compartment
and permits quick and tool-free exchange of probes.

To replace a probe the hatch at the top of the Magnet Unit must be opened:
1. Release the front hatch to expose the red button in the front of the unit.
2. Press the red button to release the top latch and open the hatch as far as it will go.
3. A second hinged lid, blue in color, will become visible. Lift this lid up and lean it against

the outer hatch.
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 WARNING
Danger of injury due to falling lid
The hinged lids may close unexpectedly during probe exchange causing injury to hands or
fingers.
u Ensure that the gas spring on the outer lid is operating correctly.
u The blue inner hinged lid does not have a gas spring, use extreme care when

exchanging the probe assembly.

4. The probe assembly is fixed with two quick-release fasteners. To release the fasteners,
lift up the D-rings until they snap into a vertical position, then use them to rotate the
fastener posts until released (refer to the figure below).

5. While grasping the D-rings, carefully pull upward to loosen the preamplifier connection
under the mounting plate, than raise the assembly (mounting bar with probe and
preamplifier attached) out of the magnet gap.

Figure 5.6: Ring of the Quick-Release Fastener (left) and the Raising of the Probe Assembly (right)

1. Rings
2. Rotating the rings.

To open the fasteners, turn the rings (1) upward and rotate them (2)

Replace the assembly by following the instructions in reversed order.
Intelligent probes were developed for the minispec mq-Series. When you exchange a probe,
the software will read the most important parameters (pulse length, resonance frequency)
from the probe itself. The software will prompt the user to confirm the settings. After
temperature stabilization it is recommended to run the Daily Check procedure. In certain
cases a fine tuning by running Update Settings may be beneficial.
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6 Getting Started
In general, minispec systems which are delivered with a personal computer already have the
minispec software installed and are fully pre-configured. In this case, the user can skip the
software installation and configuration, and proceed directly to the operational part.
The mq20 Toothpaste Analyzer operates with the minispec Plus software and with the well-
known minispec.exe software running in the background as an acquisition server. The
practical use of the software is illustrated in Running the minispec mq20 Toothpaste Analyzer
[}  33]. Moreover, the manual minispec Plus Administration, together with the manual
minispec Plus Classic, provide further details on the minispec software GUI. These can be
found on the minispec software CD/memory stick in the folder Documentation.
In general systems equipped with minispec Plus software do not necessarily need to start the
minispec.exe software before using minispec Plus. If the system is properly installed, then
minispec Plus can be opened without first opening the minispec.exe software. However in
some cases (like when the system was not shipped from Bruker directly) it might be useful to
first run the minispec.exe software to make sure there is a proper network connection from
PC to the minispec, then afterwards switch to the minispec Plus program.
When a user provides their own personal computer, or if software needs to be reinstalled for
use with the minispec, refer to the installation instructions below.

6.1 Software Installation
Execute the following steps if the PC has not been pre-configured for the minispec by
Bruker.
Please note that for proper installation of the minispec software, PC system requirements
apply. For minispec Plus operation, in addition to the specified Microsoft operation system
version, which is required for minispec.exe software operation, Microsoft Office is required
too. Each minispec software and software installation is released for one combination of
Windows operating system and Microsoft Office version. Ensure that the correct combination
is pre-installed on the PC. For further details, refer to the corresponding minispec Plus
manual.
To install the software, the following steps are needed:

1. Insert the installation CD in your drive, or when using a memory stick, insert the stick in a
USB port.

2. Open the Windows EXPLORER and check the media for a ReadMe.txt file. If a
ReadMe.txt file is available, follow the instructions provided in this file.

3. If not, execute the Setup file with a double click or select the setup entry with the right
mouse button and select Open in the displayed menu.

4. Follow the instructions in the Setup program.
´ The Setup program copies the files into the folder you specify during the setup

procedure.
5. To start the minispec.exe software, double click on the minispec.exe file in the main

folder. Alternatively, you can create a shortcut on the Windows desktop to the file
minispec.exe.

Note:
Systems that are equipped with minispec Plus software will install this additional GUI
program automatically. In this case an .ini file will carry the corresponding licenses and the
installation software will recognize known licenses and install the software GUI accordingly.
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6.2 Connecting the PC to the minispec for the First Time

6.2.1 Direct Cable Connection

1. If the minispec software is running (e.g. after installation), then close the software.
2. Connect the PC to the minispec using the blue crossed-wire UTP-cable, which is

delivered with the minispec (10-Base-T with RJ45 connectors, see the figures in the
section Installation of the minispec mq20 Toothpaste Analyzer [} 26]).

3. Power ON the instrument and computer.
4. If not already installed, use the Network entry in the Windows Control Panel to install a

TCP/IP protocol on your PC. The exact procedure for adding the TCP/IP protocol
depends on the Windows version that is used, refer to the Windows software
documentation for a detailed description.

5. Select TCP/IP Properties. Confirm or enter the following entries (for the PC): IP-address:
192.168.1.2 Subnet-mask: 255.255.255.0
´ If other values are defined, alter them accordingly. Re-boot your computer.

6. Start the minispec.exe software on the PC.
´ Some program information will be displayed for a short time, after which a Welcome

Box will be displayed. Entries in the select boxes indicate how the PC will attempt to
connect to the minispec console and what applications will be loaded.

7. Connect to the minispec unit (mq20 Series) using the indicated serial number (e.g.
NF3000) by clicking OK in the displayed Welcome Box.
´ Communication is attempted from the PC software over the TCP/IP to the CPU/

Ethernet controller in the console at the default IP address 192.168.1.1. Connection is
indicated at the top status line with a message, for example: Connected to NF3000.
The IP address of the console will be displayed in a small box on the bottom edge of
the program window.

´ If the connection with the default serial number (here e.g. NF3000) cannot be
established, retry using the IP address 192.168.1.1 instead of the default NFxxxx from
the Welcome box settings.

8. If the connection still fails, make sure the cable is a crossed-wire twisted pair cable and
that it is connected properly.
´ If connection still does not succeed, then the problem may be due to incorrect IP

addresses or Subnet mask for the PC or the minispec. Normally the minispec console
is shipped with the default IP address set to 192.168.1.1 and a subnet mask of
255.255.255.0. However, in some circumstances the minispec console may be set to
other values (e.g. if a minispec has already been installed on a network, whereas
another IP address will be needed, or a PC is being exchanged, or the software had to
be reloaded on a fresh hard disk).

´ If a connection cannot be established and the setting of the console IP address is
suspect, the Internet web browser page (service interface only) contains information
(see Help menu) on how to reset the IP address, however please check with your
local Bruker support for more details, if necessary.

6.2.2 Connection to a Network

A direct connection of the PC and minispec using the blue crossed-wire UTP cable is
recommended. When a connection to a network is desired, a second network card will help to
establish such a connection. The second network card allows the PC to be connected to the
network, while the direct connection from the minispec to the PC is still in place.
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7 Running the minispec mq20
Toothpaste Analyzer

7.1 mq20 Toothpaste Analyzer On Temperature
Once all LEDs on the mq20 Toothpaste Analyzer have switched to green, the system is
ready to run.
The PC that has been started will pause at the Windows log-in window. When configured by
Bruker, no password has been entered and the user may proceed by pressing Enter. The PC
will then finish the boot-up process and show the minispec Plus icon on the desktop. Besides
the software icon, a link to the “minispec documentation” folder is also on the desktop.

7.2 Running minispec Plus Software
Double-click on the minispec Plus icon to start the software. The software will start and come
to the log-in screen.

Figure 7.1: The minispec Plus Log-in Dialog

To get full access to all the menus of minispec Plus, type ADMIN and press the Enter button.
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You will now be transferred to the main menu of minispec Plus.

Figure 7.2: The minispec Plus Main Menu

7.2.1 Daily Check

As a first action, chose to run the Daily Check function to validate the mq20 Toothpaste
Analyzer system. The software will now guide you through the procedure, requesting the
Daily Check sample. Insert the corresponding sample with care into your NMR system.

Finally the test should conclude and the instrument should be valid for 24 hours. In case
there is a Daily Check failure, it is recommended to run the Update Settings procedure and to
follow the corresponding instructions. In any case if the Update Settings routine does not run
automatically, the Daily Check procedure has to be repeated.
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During Daily Check, the system runs a number of tests, all following one after the other.

If all the tests passed, the software will indicate this accordingly. The corresponding message
will also be displayed in the main menu.

7.3 Calibrations
TD-NMR is a secondary technique and as such the Toothpaste Analyzer needs to be
calibrated with reference standards.
For all other applications the customer will need to calibrate the system with their own
reference standards. Typically 4-6 standards with known reference values are needed per
calibration line. In most cases the mq20 Toothpaste Analyzers are calibrated in a classical
way, i.e. the NMR signals of FID or Hahn-echo (or both) are considered and the
corresponding amplitudes are correlated with the sample properties.
For different types of samples (like different types toothpaste or mouthwash) the user may
need to create different calibration lines, one line per type of sample. It is recommended to
name the calibrations accordingly.
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The user may choose the Calibrate button and proceed to the Calibration menu.

Create a new calibration and select a corresponding name.

Choose the corresponding Bruker pre-defined method and double-check the number of
scans.
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The user may also define a reference sample / standard that can be measured periodically by
the instrument.

Moreover for the Fluorine in Toothpaste applications the number of scans (NS) and the
recycle delay (RD) time may differ in the calibration and in the measurement part. Per default
the same numbers are applied. However, also different parameters are possible.

Users that need to create one calibration, but like to apply different parameter sets of RD and
NS for the measurement, can create one calibration and duplicate it (including calibration
points). This way only one calibration has to be established, but multiple sets of RD and NS
can be applied for measurements of unknown samples.
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Start the calibration and tune the gain with the sample that has the highest NMR signal
(typically the sample with the highest mass/highest concentration).

After Gain Adjustment one calibration sample after the other is analyzed. Depending on the
application one or two parameters are calibrated. It is also possible to calibrate for 2 values
simultaneously. Start with the first sample. As the Gain is fixed now, the order in which the
calibration samples are measured does not matter.

The calibration measurements are shown on the screen.
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After the first sample is done, go on with further calibration samples. By default the
software  requests a minimum of 3 samples per calibration parameter. However often the
calibration can be improved by including further samples, for example 5 or 6.

When the measurement of all the samples is completed, switch to the calibration results.

Afterwards move forward to the calibration line and inspect the correlation and other
parameters describing the calibration quality.
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You might add samples or delete some, depending upon the needs and results of the
calibration.
As the very last step and when the calibration  fulfills the requirements, the calibration is
signed. From then on it cannot be modified any further.

The only way to continue to work with this calibration is to make a duplicate of this calibration
and also copying the calibration data points.
If the calibration is signed, one may leave the calibration section and switch to the
Measurement part or the Calibration Validation measurements are executed. Here a defined
sample is measured on a daily base and the results are recorded by the software for
stability / performance check and also as a validation tool.

Once the Calibration validation measurement has completed, the result will be displayed on
the screen and added to the list of Calibration Validation measurements for statistical
analysis.
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Afterwards switch back to the main menu of minispec Plus to start running measurements of
unknown samples.

7.4 Measurements of Unknown Samples
When the calibration(s) is(are) finished, one may switch to the “Measurement” section. Here
unknown samples are analyzed and measured according to the calibration curve selected by
the user.

• Enter the batch name of the sample to be analyzed.

• Select the corresponding calibration method. Note: once batch and calibration are chosen,
those are connected to each other. The software then remembers this connection when
doing further measurements.

• Depending upon the method, as it has been defined during the calibration, the sample
may need to be weighed. Enter the corresponding sample weight into the software or get
the mass transferred from the balance connected.
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• Insert the sample into the NMR as instructed by the software and see the measurement
progress.

• Once the measurement has completed, the result will be indicated and displayed on the
screen in large letters and also on the results list.

• Proceed with the next measurement or leave the Measurement menu.
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7.4.1 Result Handling

As unknown samples have been measured, the results are archived into the minispec Plus
data base. Going to “Results” the data can be sorted / selected according to criteria such as
time span, user etc.

Once selected one may sign the data (Sign function).

Or export data either to ASCII file or to MS Excel.
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Exporting to MS-Excel templates are used so that the data is presented in the most clearly
arranged way.

7.5 Administration Details
minispec Plus comprises an extensive Administration section. Also for this part counts: the
most prominent features for your application should already be factory set and for most of the
customers there will be no reason to access this part of minispec Plus. This part can only be
accessed by an user with Administrator permissions.

Not mentioned so far is the fact that minispec Plus runs with 3 permission levels:
• Administrators with full access.
• User with “Calibration” permission having access to the Calibration and the Measurement

parts.
• User with “Measure” permission having access to the Measurement part.
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Moreover the minispec can be configured, please see the next screenshot. The minispec
serial number as well as software installation path can be set. However – if the software runs
for instance the Daily Check successfully, then there is no need to do any modification on
those settings.

Calibration settings can be specified in minispec Plus, for instance the number of calibration
samples to be measured as a minimum – despite the below example, we recommend a
minimum of 3 calibration samples per parameter to be analyzed. This is also the default
setting in minispec Plus software.
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Finally application settings can be defined in minispec Plus – we recommend to approach this
only in case your designated application cannot be selected within the calibration section of
minispec Plus.

7.6 More Details
For further details on the calibration procedures, measurements, results archiving,
administration please refer to the dedicated minispec Plus manuals dealing with those
matters in much more detail.
The following manuals exist:

• minispec Plus Administration
• minispec Plus Classic Applications
• minispec Plus Chemometric Applications (optional)

For the mq20 Toothpaste Analyzer there exists an SOP (Standard Operating Procedure) that
explains calibration and measurements.
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8 minispec.exe Software for
Diagnostic and Service Purposes
The software minispec.exe described in this chapter is typically not used by mq20 Toothpaste
Analyzer users. For these users the software minispec.exe is mostly applied only for
diagnostic and service purposes. Nevertheless a description of this software is provided here.

8.1 Configuration of minispec.exe

8.1.1 Wake-up State of the minispec.exe Software

When the software starts, a general dialog is displayed concerning the software version and
the copyright. Then a Welcome Box opens and displays information about the configuration
of the system. The wake-up configuration is the configuration used with your last
minispec session. To continue with the same settings and start the minispec software click
OK. If you want to change the settings refer to the next section, Configuration of the
Software, the Welcome Box [} 47].
As already mentioned the standard software of mq20 Toothpaste Analyzer is the minispec
Plus software. Corresponding manuals for this software are also available on the minispec
CD/memory stick (for a list see Introduction [} 23]).

8.1.2 Configuration of the Software, the Welcome Box

The configuration of the system (i.e. the connected minispec, the selected applications, the
analyzer type, and the calibration permission) can be inspected and edited via the Welcome
Box. The Welcome Box can also be user configured. Users can control whether or not this
box will be opened on program start. This is done by selecting or deselecting the entry
Welcome Box in the pull-down menu View (see also The View Menu [}  65]). Deselecting
the item Display this Window on Startup will also turn off the Welcome Box when the box
appears on program start.
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Figure 8.1: The Welcome Box

Several symbols, entries and buttons are displayed in the Welcome Box:
• Applications to be loaded (path and file name in the white field).
• Serial number of the minispec to be connected to (here: NE3449).
• Type of analyzer (here: NMR Analyser).
• The calibration permission is symbolized using a flag.

The wake-up application can also be selected for future program start-up. When the user has
finished with the selections, the OK button is used to start the software.
To change the configuration, press the Setup button. The configuration is protected by a
simple log-in mechanism.

• First log-in: Press the Setup button. Enter and confirm a password. The password will be
saved automatically and you will need it for every subsequent log-in. Handle the
password carefully! Only users who have permission to make changes to calibrations
and software configurations should have knowledge of the password. If password
protection is not desired, simply click OK or <Enter> without entering a password when
the password entry box appears and confirm this in the following box.

• Later log-in: Press the Setup button and enter the password or click twice on OK if
password protection is not used.

8.1.2.1 Selecting Applications and Connections

If you click Setup in the Welcome Box you will open the configuration level of the welcome
dialog. This password procedure is described in the section above. Up to 20 applications can
be selected to be loaded at the startup. To add applications to the list use Browse... to
access a file selector box or use Delete to remove applications from the list.
To choose another minispec, use the Select button in the Select minispec to connect to field.
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8.1.2.2 Changing Analyzer Type and Calibration Permission

Use the Customize button in the configuration level (see Selecting Applications and
Connections) to open a dialog box. In this window the analyzer type and the calibration
permission can be selected by checking the corresponding select box with a mouse click.
Two options, RELAXATION TIME and the NMR analyzer, require a license number to
operate. The number will be requested while connecting to the minispec (after you click the
OK button in the Welcome Box) when one of these options is selected. If ordered with the
system, this license number is issued on the first page of this booklet, labeled as the ExpSpel
license number.

8.1.3 General Measurement Handling

The most important commands that are used to control measurements are: the Run
command to start a measurement and the Stop command to interrupt a measurement in
progress. Measurements can be started through a number of commands and by activating a
number of software icons or features. For example, the general Run command can be started
through the RUN button from the top icon bar or bottom button panel, from the pull-down
menu minispec, or by simply pressing <Enter>. If the user has been given permission to
perform sample calibrations, then the Calibrate command is available. Other forms of
measurement are available for convenience, including a repetitive run command and a
command to detect the raw NMR signal.
The following sequence of actions is generally followed in preparation for measurements:

1. Turn on your minispec and your PC (if they were turned off).
´ Wait until the console CPU/Ethernet process boots, as indicated by the lighting of the

left (green) LEDs located on the front edge of the magnet and console.
2. Connect the PC to the minispec you want to use and configure the software, e.g. choose

applications or an analyzer type.
´ Wait until the right LED on the magnet unit is green. This can take up to 3 hours to

ensure optimum temperature stability. If the system was turned off for several days, or
it was moved to another place, insert the calibration sample with 0% solid content and
run the Update Settings routine.

3. Depending on the application you use (see your application description), start your
measurement or calibration with the Run or Calibrate command.

The software includes full automatic tuning routines to adjust the measurement settings, for
example pulse length, receiver gain, and magnetic field. You can tune these settings
periodically to ensure the instrument validity over time.
The Daily Check command should be executed once a day to check the most important
instrument settings and hardware functionality.
Every 24 hours, a yellow field on the right of the display will automatically indicate the need
for another Daily Check. Running the Daily Check periodically ensures conformance to
Good Laboratory Practice (GLP).
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8.2 minispec.exe Standard Windows
The minispec user interface provides access to all menu functions, parameters, application
programs, NMR signal display, and measurement results. In order to provide ready access to
commonly needed views of the software operations, the screen is divided into different parts.
To facilitate measurement handling and provide easy access to command commands, icon
bars have been integrated into the user interface, and windows are available for the control of
the measured signal (Signal Window) and the results (Result Window, Statistics Box).

Figure 8.2: The View of the Signal Window, Result Window and the Spread Sheet.

For the pre-configuration of measurements and a simplified data output a Spread sheet/
database Window is integrated in some applications. Furthermore, the interface layout is
adjusted to the individual needs of the analysis for most of the recent standard application
fields.
The functionality of the windows, i.e. the possibility to move them, depends on the
analyzer type you are working in. Repositioning of bars and windows is only allowed
for the relaxation time and the NMR Analyzer.

8.2.1 The Signal Window

The Signal Window displays the measured NMR signal or the fit results graphically. In some
analyzer configurations (NMR and Relaxation configurations) the display can be resized.
Scaling of the data and the type of symbols used for the presentation of results can be
adjusted from the View pull-down menu, again depending on the analyzer type. Data
displayed in the Signal Windows can be saved to a file with the extension ‘.sig’ using the
command Save or Save Copy As from the pulldown menu File.

8.2.2 The Results Window

The Result Window is an output device for minispec applications that uses the ExpSpel
command print_line(RESULTBOX,...) to display a record of the evaluated result.
Results are printed in the Result Window in ASCII text format. The results can be stored
using the Save or Save Copy As… command from the pull-down menu File. Contents of the
Result Window are automatically saved at intervals to a file with extension .mdt). To
determine the parameters of the save procedure, use the command Save Setup in the pull-
down menu Save.
Result files can also be read with a common text editor. One can select and copy the data to
the clipboard as ASCII text with the command Copy in the pull-down menu Edit. To toggle
between the normal and the large font result box, mark / unmark Large Font Result Box
from the View menu.
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8.2.3 The Spreadsheet Window

Spreadsheets have a number of functions in the minispec software:
• They allow a clear data input for the preparation of a measurement series.
• They give a listed view of the measurement results.
• They allow the data to be saved and post processed in common file formats (like MS

ACCESS/EXCEL).
• A spreadsheet will be displayed automatically if it is implemented in the loaded

application.

8.2.3.1 Execution of Spreadsheets

Normally the tables are executed after RUN is selected, beginning from row one to the end of
the entries. But you can also measure single rows of the table by marking these lines and
then selecting RUN. This may be useful if not all samples are prepared at the beginning of
the analysis or if several measurements should be repeated.

8.2.3.2 Saving Spreadsheets

Spreadsheet data are saved automatically every time an entry is changed and any time the
ENTER key is pressed. The filename is generated by the minispec software:
<application>\MMMYY\DD\hh\mm\ss.mdb with:
<application>: path of the current application
MMM: month (Jan, Feb, Mar,..., Nov, Dec)
JJ: year (99, 00, 01, ...)
DD: day (01, 02, ..., 31)
hh: hour (00, 01, ...23)
mm: minute (00, 01, ..., 59)
ss: second (00, 01, ..., 59)

Saving in ASCII-format
The files can be saved alternatively in ASCII-format by using the Save or Save Copy As
commands. The file name will be prompted in a standard file selector box, and the file
extension used is *.tab. The first row of the data includes the headlines of the spreadsheet,
the columns are spaced with a <TAB>. The ASCII tables can also be opened with standard
text editors like NOTEPAD/WORDPAD or MS-EXCEL.

8.2.3.3 Monitoring

During a measurement the spreadsheet is updated by the minispec software every time a
result is added. The tables can be opened on the measurement PC or any other PC
equipped with the minispec.exe software or MS-ACCESS 2013. External monitoring of the
measurement results via a network connection is therefore possible.
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8.3 minispec.exe Menu Functions
The minispec software provides many opportunities for data display, data saving, and
measurement handling. This chapter describes all functions that are available when the
software is configured as NMR-Analyzer.
When the minispec is used only for specialized applications (Fluorine, etc.) many of these
functions are unnecessary. In this case, the number of menu options is reduced to simplify
the interface and make the software easier to use when the configuration is adjusted to
certain analyzer types. Commands whose functionality may be not reasonable in some
contexts appear grayed or may no longer be visible. The actions of the functions are
described below.

8.3.1 The Bars

The minispec software menu structure and toolbars are designed within the framework of
most standard Windows software to ensure intuitive handling (see the screen layout in the
figure below). In the Menu bar actions can be selected via pull-down menus. Icons are also
used for commonly used actions and remain visible in the Standard toolbar. Depending on
the options selected, the most important commands for the execution and abortion of
measurements may also be accessible through large icons on a Measurement toolbar,
which is usually positioned at the bottom of the screen below the signal window. In the
Result bar the numerical result(s) of the last measurement is displayed. The Info toolbar
contains easily selectable buttons pertaining to the instrument status and parameter display,
as well as a list of loaded applications. Finally, the status of the measurement and
connections are summarized in the Status bar. The functionality of these items is described
in the following sections in detail.
Adjustment of the bars (i.e. the possibility to move them) depends on the configuration of
analyzer type you are working in. Repositioning of bars and windows is only allowed for the
relaxation time and the NMR Analyzer.

Figure 8.3: The Default View

The arrangement of the different bars supports an intuitive measurement handling.
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8.3.2 The File Menu

The list of items in the Menu Bar depends on the active window. If the Signal Window is
active, and an application is loaded, all entries are visible. The functions of the menu can be
activated by a mouse click, or alternatively, using a keyboard shortcut (Alt + underlined
letter).

By activating the File menu all commands necessary for file handling are available (see
figure). Their use is in analogy to conventional Windows software, you can open, close, save
or print the contents of the selected windows (or the whole application).

Figure 8.4: The File Pull-Down Menu

The Open Command
Shortcuts: Standard Tool Bar:

Keys: CTRL+O
Use this command to open an existing document in a new window.
One can select either:

• A complete minispec application (filename extension .app) consisting of maximum four
windows: an editor window with ASCII-text in ExpSpel programming language; the Signal
Window with the measured signals; the Result Box; and in some cases a spreadsheet.

• Measured signals (filename extension .sig) and measured data Result Boxes (file name
extension .mdt) separated from its minispec application.

• Diagnostics files.

The Close Command
Use this command to close all windows in the active application or document.
If the focus is on one of the four views (windows) of a minispec application, the complete
minispec application with all views will be closed.
Shortcut: Standard Tool Bar:

If you want to close all applications use:
Shortcut: Standard Tool Bar:
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The Save command (Save As, Save Copy As)
Use the Save command to save the active document to its current name and directory. When
you save a document for the first time, the minispec software displays the Save Copy As
dialog box for input of a name. If you want to change the name and directory of an existing
document before you save it, choose the Save Copy As command.
If you want to make a copy of an existing document, choose the Save Copy As... command.
Shortcuts: Standard Tool Bar:

Keys: CTRL+S

The Save Setup Command
The Result box displays results derived from the NMR data (after evaluation steps defined in
the minispec application). Results are automatically saved as ASCII text at intervals (file
extension: .mdt ).
To set the parameters for the save procedure, select Save Setup from the result box file
menu:

Figure 8.5: The Dialog Box for Data Saving Setup

Select Default Storing to backup every 100 result box lines of measured data to the file
<application>.mdt in the current working directory.
When you attempt to exit the minispec application, the system will prompt whether the data
should be saved, deleted or copied into another file.
Select Don't Prompt Saving to deactivate the prompt when saving, in which case the
unsaved parts of the result box are then saved automatically. After reloading the minispec
application, the results will be erased before the first new results are outputted to the Results
box.
Select Automatic Storing for an automatic documentation of measured results.
The default path for saving is:
<current application directory>\<MMMJJ>\<ddhhmmss>.mdt
MMM: month
JJ: year
dd: day
hh: hour
mm: minute
ss: second
To modify the default path setting, select Browse... and define another folder. Default saving
is every 100 lines and when leaving of the minispec application.
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You can modify the default data saving behavior using Measured Data Backup every....
To include an output of the instrument and acquisition parameter settings, select Settings
Print Out in Results Header. These settings are dependent on the minispec applications.

The Print Command
Use this command to print a document. It opens a Print Dialog Box, where you may specify
the range of pages to be printed, the number of copies, the destination printer, and other
printer setup options.
Shortcuts: Standard Tool Bar:

Keys: CTRL+P

The Print Preview Command
Use this command to display the active document as it would appear when printed. The main
window will be replaced with a print preview window in which one or two pages will be
displayed in their print format. The Print Preview toolbar offers options to view either one or
two pages at a time, movement back and forth through the document, zoom in and out of
pages and to initiate a print job.

The Print Setup Command
Use this command to select a printer and a printer connection. This command presents a
Print Setup dialog box where the printer and its connection are specified.

The 1, 2, 3, 4, 5 Commands
Use the numbers and filenames listed at the bottom of the File menu to open the last five
documents you closed. Select the document you want to open.

The Exit Command
Use this command to end your minispec session. You can also use the Close command. The
minispec software prompts you to save documents when unsaved changes exist.
Shortcuts: Headline:

Keys: ALT+F4
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8.3.3 The Edit Menu

The list of commands in the Edit pull-down menu depends on the active window (see figure
below). In the following description all commands are included to ensure a complete
documentation.

Figure 8.6: The Edit Pull-Down Menus for Different Active Windows

In the figure above, the left side shows the menu when the Signal Window is active, and the
right side when the Results Window is active.

The Copy Command (Copy as Data, Copy as Bitmap)
Use this command to copy selected data into the clipboard. This command is not available if
no data is selected. In the case of signals, data are copied as x-, y- (, z-) data in ASCII
format, to allow an easy transfer to Excel. Use Copy as Bitmap from the Edit menu to copy
signals as bitmap to the clipboard.
Shortcut Keys: CTRL+B (Copy as Bitmap)
Shortcut Keys: CTRL+C (Copy as Data)

The Select All Command
Selects the entire content of the Result Window. In the Signal Window this command is only
valid in connection with calibrations.
Shortcut Keys: CTRL+A

The Unselect All Command
Unselects the entire content of the Result Window. In the Signal Window this command is
only valid in connection with calibrations.
Shortcut Keys: CTRL+U

The Erase All Command
Erases the entire content of the Result Window, without erasing the data from the
corresponding automatically saved measured data file.
Shortcut Keys: Del

The Find Command
Use this command for searching and highlighting words or text fragments.
Shortcut Keys: CTRL+F
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8.3.4 The minispec Menu

All commands concerning instrument settings are included in this menu item. The commands
for the magnet heater calibration and the receiver tuning are only available for BRUKER
service personnel and therefore are grayed with a normal software startup. The list of
commands depends on the status of the instrument (see figure). If there is no application
loaded, the list is enlarged by the commands Connect and Disconnect.

Figure 8.7: The minispec Pull-Down Menu

The Connect/Disconnect Command
Once the system requirements for TCP/IP have been fulfilled, a software link between the
minispec software running on a PC, and the minispec must be initialized. To establish the PC
to minispec connection, select minispec Connect. Alternatively you can select Connect in
the Welcome Box.
Enter the minispec Serial Number when prompted by the Connection Dialog Box.
The minispec Serial Number must be a valid entry in the MS-Windows ’hosts‘ file and have
the form 'NBxxxx' for NMS- or 'NDxxxx'/'NFxxxx' for mq-systems.
The minispec serial number, which is the host name of the minispec, is used to identify the
BRUKER minispec, controlled by the minispec software that is running on a PC in a TCP/IP
network. It is recommended to add the IP address of the minispec and its corresponding
Serial Number to the Windows ‘hosts‘ file on the PC, if not already done by the software in
the setup procedures described earlier (section Connecting the PC to the minispec for the
First Time and Wake-up State of the minispec.exe Software).
To add the IP address and the serial number of the minispec:

1. Open the file ‘hosts‘ from the Windows folder (e.g. ‘notepad‘).
´ In the case you work with Windows NT the hosts file is placed in the directory:

system32\drivers\etc\.
2. Add a line in the following form to the file: <IP address><Space><minispec Serial

Number> Where <IP address> is the network wide unique IP-address in the form
‘xxx.xxx.xxx.xxx’, and <minispec Serial Number> is the minispec Serial Number of the
form ‘NBxxxx’, ‘NCxxxx’, ‘NDxxxx’ or 'NFxxxx'.

Use the command Disconnect from the menu to disconnect from the current minispec (e.g.
prior to reconnecting to another minispec).
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The Instrument Settings Command
Minispec instrument settings (see the figure below) are instrument dependent values such as
the pulse lengths and the magnetic field at NMR resonance. Instrument settings differ from
minispec to minispec, and must be tuned the first time a minispec is connected. You can use
this command to change the settings of the instrument with manual input.

Figure 8.8: The minispec Settings Table

You can change the listed settings by manual input or with the Update Settings and Daily
Check commands. Greyed entries are disabled.

Shortcut: Standard Tool Bar:

The settings that can be changed are shown in the figure above. If the minispec Settings
are disabled on a connected minispec, customize your minispec software (through the
Welcome Box) to access the calibration parameters.
The Advanced button in the settings table allows access to a list of instrument setting table
names. The user may select the appropriate settings table to be used by the instrument,
define custom names for the settings tables with the help of the Customise button (e.g.
settings table name could be set to the probe name), and save the current entries under a
new name.

The Tune Settings Command
When the minispec is first connected to the PC, all instrument settings must be tuned starting
from default values. This can be done with the Tune Settings command. The routine will
tune all settings of the instrument without user prompting. If the Tune Settings menu stays
disabled on a connected minispec, customize your minispec-software to get access to the
calibration parameters.

The Update Settings Command
A blue mark (validated) symbol on the right side of the Info Toolbar indicates a well checked
minispec instrument.
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An update of the instrument settings can be done periodically to check the instrument validity.
An update may be necessary after the system has been relocated or the probe assembly has
been changed. An instrument settings update is also recommended if the Daily Check fails.
The Update Settings routine is faster than the Tune Settings routine, as it starts from pre-
adjusted settings (listed in the current instrument setting table). The Update Settings routine
also the update of selective settings, whereas the Tune Settings command will tune all
settings without further user prompting. For instrument optimization it is recommended using
the Update Settings routine. For the initial tuning of the settings, the Tune Settings is the
method of choice.
If the Update Settings menu stays disabled on a connected minispec, customize your
minispec software (through the Welcome Box) to provide access to the calibration
parameters.

The Daily Check Command
This option tests the instrument tuning but does not change the instrument settings. A quick
check is recommended once a day (every 24 hours). A checkmark (Checked) in the Info
Toolbar signifies a well-checked minispec instrument. An un-calibrated minispec instrument is
indicated by a yellow mark (Check!).

To run the Daily Check, use the corresponding toolbar button or select Daily Check from the
menu. If one of the checks fails it indicates that an instrument setting is not optimized. Use
the Update Settings command to perform an update.
Shortcut: Info Toolbar:

The Balance Settings Command
One can connect a scale by serial interface to the PC's communication port in order to
electronically transfer sample weight information (weights are necessary for some absolute
applications). To enter the port configuration dialog, close all minispec applications, then
select Balance from the Setup menu. Access is limited to users who have permission to
enter the minispec main menu or calibration. Select the balance type, then the port to
connect the balance to. Select the port parameters according to the settings on the scale. To
set the standard values, click <Default> before leaving the Settings Table. To leave the
Settings Table unchanged, click <Cancel>. To re-load old settings from file after
modifications, click <Re-Read>. To leave the Settings Table with the new values, click <OK>.

The I/O Port Settings Command
One can connect serial interface devices, such as balances, thermostats or sample
changers, to the PC's communication port. To get the port configuration dialog, close all
minispec applications, then select 'I/O Port' from the 'Setup' menu. Note: To get the minispec
main menu, the R&D level or calibration permission must be given. Select the port
parameters according to the settings on the connected device.
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The Licenses Command
Some special applications, like the digital pulse attenuation and the pulse shaping need to be
licensed. Use this menu to open the license number input box, which prompts the user to
input the license number. After a successful license procedure, the menu entry is checked
and grayed.
Have ready the minispec instrument's system number (see Status Bar ) and contact
BRUKER for information or license numbers.

8.3.5 The Measurement Menu

All commands concerning the execution of measurements are concentrated in this menu item
(see the figure below). Since these commands are used frequently, quick select buttons are
available in the Measurement Tool Bar and key short cuts exist to enhance accessibility.

Figure 8.9: The Measurement Pull-Down Menu

The Run, Stop and Continue Commands
The Run command starts a measurement. If the Sample Detector is set ON (see: Instrument
Settings Command) the measurement will be executed automatically with the insertion of the
sample.
Shortcuts: Standard Tool Bar:

Measurement Tool Bar:

Keys: ALT+M or ENTER
To interrupt a minispec measurement, use the Stop command.
Shortcuts: Standard Tool Bar:

Measurement Tool Bar:



minispec.exe Software for Diagnostic and Service Purposes

E1400912_1_001 61

The command Continue is used to leave an intermediate process in order to continue
running the minispec application (e.g. during a waiting time, a data acquisition or a fit
display).
Shortcuts: Standard Tool Bar:

Measurement Tool Bar:

Keys: ESC

The Calibrate Command
A typical minispec application detects NMR signals of the sample and then calculates the
result from the NMR signal. In some cases, the result can be directly calculated from the
measured signal (e.g. a relaxation time). In other cases the minispec applications may use a
reference method and calibration line to determine a sample property (e.g. oil, water or fat
content) from the NMR signal. As a consequence, the NMR signal must first be calibrated
with respect to sample properties. Select Calibrate Sample from the Measurement menu.
Shortcuts: Standard Tool Bar:

Measurement Tool Bar:

Keys: ALT+C
Running a minispec sample calibration leads the user through several steps. In most cases
some application specific values (see: The Application Parameter Table Command) need to
be defined.
To calibrate a minispec application, proceed as follows:

1. Prepare at least 3 samples of known content for measurement.
2. Perform test measurements with each calibration sample to adjust the acquisition

parameters from the Acquisition Parameter Table in the Parameter menu. Adjust the
receiver gain to the sample with the strongest signal.

3. Save the parameters and leave the parameter table.
4. Run the sample calibration and follow the prompts.

A flag in the Info Toolbar indicates a calibrated minispec application.

An uncalibrated minispec application is labeled with the following flag:
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The Detect raw Signal Command
In some cases, for example to adjust the acquisition parameters, it might be helpful to detect
the signal without data processing. This command was implemented to execute only the
pulse sequence and acquisition without data processing or result output.
Shortcut: Keys: ALT+S

The Run Repetitive Command
With this command a measurement can be repeated several times at a regular interval.
Shortcut Keys: ALT+R
Select 'Repetitive Measurement Settings' from the Parameter menu to determine the
waiting time in seconds before a repetitive minispec measurement, the delay between two
successive repetitions, and the maximum number of repetitive measurements.

8.3.6 The Parameter Menu

All parameters for acquisitions, applications and repetitive measurements can be defined with
the assistance of the commands in this menu:

Figure 8.10: The Parameter Pull-Down Menu

8.3.6.1 The Acquisition Parameter Table Command

Acquisition parameters are application dependent values (for example receiver gain, recycle
delay and number of scans to accumulate) that help define data acquisition. These values
can be modified when a minispec is connected to the PC and a minispec application has
been loaded. To modify acquisition parameters open the Acquisition Parameter Table.
Shortcuts: Standard Tool Bar:

Keys: ALT+P
To save the modifications to file, click <Save> before you leave the Parameter Table.

Note: Calibrated minispec applications will loose their calibration, if parameters are changed.

If the Save button stays disabled on a connected minispec, customize your minispec software
to provide access to the calibrated application.
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Experiment parameters that can be edited through the Acquisition Parameters menu:

Figure 8.11: The Acquisition Parameter Table

Scans (1 – 32000)
Scans is used to set the number of times the NMR experiment should be repeated for signal
averaging before the result is evaluated. The required number of scans depends on the
signal strength, the desired signal-to-noise (which will limit the precision of the
measurement), and the desired speed of analysis (time between scans is set by the Recycle
Delay). Signal to noise improves with the square root of the number of scans. The remaining
number of scans during an experiment is shown in the lower right corner of the display.

RD (seconds)
RD, or Recycle Delay, is used to set the time delay in seconds between repeated scans. The
recycle delay is usually set just a little longer than the relaxation time of the sample. If the
delay is deliberately made shorter than the sample relaxation time, one or more dummy shots
can be made prior to the experiments in order to ensure that the first scan has the same
history as all subsequent scans.

Gain (dB)
Gain sets the signal amplification in the receiver. For best results, set the gain such that the
highest part of the signal reaches about 90% of the signal input range.

Note that the gain should not be changed for calibrated applications. If the range of input
signals is too large for one gain setting, it may be better to have several calibrations for
different gain settings.

Dummy Shots (0 - 32,000)
Pulses before the measurement can be made prior to the experiments (<Setup> <Program>
Menu), in order to ensure that the first scan gas the same history as all subsequent scans.
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Mag Cycle Steps (0 - 2048 Steps)
The Mag Cycle Steps provides a method of improving the performance of the detection
system for multi-scan measurements. Instead of accumulating all scans on resonance, the
magnetic field is cycled symmetrically about the resonance in steps, their size depending on
the field cycling range and the number of scans.

Detection mode (magnitude/real/imaginary/complex)
Sets the mode of signal detection. “Magnitude” detection calculates the root of the sum of the
squares of the real and imaginary parts of the signal, which are recorded by the quadrature
receiver. The “magnitude” mode is independent of the detection angle, and not as sensitive to
off-resonance effects of the magnetic field, but does not include any signed information (i.e. is
always positive). Data recorded in complex mode has a real and imaginary component and
can be Fourier Transformed for viewing in the frequency domain (see The Process Menu
[} 69]).
For applications requiring phase information (e.g. T1 relaxation), the in- and out-of-phase
components can be measured separately using the “real” and “imaginary” modes
respectively. If the detection angle and the magnetic field have been adjusted optimally, the
real component will be at maximum and the imaginary component will be zero.

Digital Bandwidth (1-20000 kHz)
The Digital Bandwidth is used to set a digital filter. For very weak and noisy signals, the
digital bandwidth should be set as low as possible without distorting the signal shape.
NF systems come with a digital filter which means that the dwell time is related to the setting
of the digital filter. Changing the digital filter from the standard value in the application
software may lead to non-sense NMR signals. Make sure the relation between digital filter
and dwell is understood and set accordingly.

8.3.6.2 The Application Configuration Table Command

The most common minispec applications can be configured for the special requirements of
the current measurement (e.g. whether the liquid or solid fat content has to be determined).
The command opens a table where the application options can easily be edited.
Shortcuts: Standard Tool Bar:

Keys: ALT+P
The Application Configuration Table is optional, not all minispec applications need a sample
calibration or configuration, thus the configuration table may not be available for these
applications.

8.3.6.3 The Acquisition Pre-Delay Time command

In some cases a defined delay is desired between the time a sample is inserted and the time
of measurement start (e.g. if time is needed to allow the temperature of the sample to
equilibrate in the magnet). The Acquisition Pre-Delay Time command allows such a delay
to be set. The waiting time is added to the recycle delay of the first scan of the data
acquisition. Once a measurement is triggered, you can override the acquisition pre-delay and
continue with data acquisition by selecting the Continue command.
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8.3.6.4 The Repetitive Measurement Settings Command

Repetitive measurements require several control parameters. When this command is
selected, a table appears where the following parameters can be specified: the waiting time
in seconds before a repetitive minispec measurement begins, the delay between two
successive repetitions, and the maximum number of repetitive measurements.

8.3.7 The View Menu

Each user can configure the screen for the special requirements of a measurement. With the
help of the pull-down menu View one can adjust the arrangement of the different windows,
the display of toolbars, the font size for the result output and much more. The list of available
commands depends on the active window and the active application:

Figure 8.12: The View Pull-Down Menu

The View Default and the Toolbars Commands
The minispec software shows four tool bars: the Standard Tool Bar, the Result Bar, the
Measurement Tool Bar and the Info Tool Bar (see the figure above). When the minispec
software is configured as the Relaxation Time or NMR Analyzer type, all toolbars are docking
toolbars. This means that the toolbars can be moved to any location on the entire screen by
pressing and holding the left mouse key. The location can be outside of the minispec
software main window, within the main window docked (e.g. on the left, right, top or bottom),
or switched off entirely. To switch toolbars on and off, mark/unmark the corresponding toolbar
in the minispec application menu View.
To get an impression of the toolbars and to restore the default screen select View Default.
Shortcut Keys: ALT+V

The Info Views Command
This command is subdivided into four parts:
1. minispec Settings: If you choose this item you will get a table of all minispec application

relevant instrument settings and parameters. 
Shortcut: Info Toolbar:
The function is disabled (grayed) if no minispec is connected.

2. minispec System Status: The user can get a real-time indication of the status of the
minispec instrument, particularly:

– Magnet Unit temperature and status.
– Sample orifice status (sample inserted or not).
– Sample insertion detection (grayed if sample detection is set OFF.
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– Transmitter power status.
– Heater power status.
– Electronic Control Unit temperature status (grayed if Control Unit temperature

detection is set OFF.
– External Gradient Unit status.
– Possibility of attenuated and shaped pulses.

The entries are marked with a checkmark ( ) when the corresponding item status is OK.
Shortcut: Info Tool Bar:

3. Results Mean. This function displays the Statistics Box (see figure), a window which
allows general monitoring of measurement results. The Statistics Box contains:

– Mean value.
– Standard deviation.
– Current data value.
– Total number of data.
– Maximum value.
– Minimum value.
– Difference between minimum and maximum value.
– Graphic representation (Statistics “Meter”).

The window can be minimized with the double arrow in the upper right part of the box (see
figure). Only the graphic view will be displayed in the minimized form. The green area in
the graph displays the range of tolerance for the measurement, the vertical lines through
the meter indicate the actual values, and the continuous broad vertical line represents the
mean value.

Figure 8.13: The Statistics Box
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4. Fit Info: You can display a window containing all information of a current fit. An active Fit
Window is marked with a check mark.

The Display Modes Command
Different display modes are available for the measurement signal. Possible modes are:

Figure 8.14: Display Modes

You can activate the desired display mode with a mouse click.

The Display Scaling and the Display Cursor Commands
There are various possibilities for the data and cursor display. With these commands the
scaling of the Signal Window and the options for the cursor displays are adjusted. For easy
handling the commands can be executed using short cuts. The following display operations
are available:

Resets the display to the default view.

Adds a grid to the signal display.

Toggles between separate or overlapping displays of real and imaginary signals.

Toggles between Full Scale (the limits are the highest and lowest values to be displayed)
and normal (100%) signal scale.

Zoom Scale on / off. To zoom, mark the signal with the rectangle cursor. Using the left
mouse button you can toggle between the left/upper and the right/lower limit. The zoom
range is defined using the right mouse button. To reset, use the right mouse button or click
the Reset button.

Fix Scale on / off. Fixes the display scale (e.g. after zooming) and the display type if used
before a measurement.

Data Cursor on / off. Allows the data cursor to be moved with the mouse or cursor keys.
When activated, data point information is available in the Status Bar.

Distance Cursor on / off. Allow the mouse or cursor keys to be used to position the distance
cursors. Use the left mouse button to toggle between the left and right distance cursor. Data
points distance information can be found in the Status Bar.
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Marker Cursor on / off. Use the mouse or the cursor keys to position the data cursor. You
can observe data point information (and the distance from the fitted value) in the Status Bar.
The field is only active if a calibrated data file for the application exists.

Note: Zooming, data, distance and marker cursors can only be used exclusively.

The Welcome Box Command
On the BRUKER minispec program start, the software wakes up with the Welcome Box (see
also section Configuration of the Software, the Welcome Box). The Welcome Box offers the
possibility of adapting some software settings to the user’s purposes (e.g. selecting a
minispec application or connecting a minispec). To switch off the Welcome Box, uncheck
Display this Window on Startup in the Welcome Box. On restarting BRUKER minispec
software, the last minispec connection and minispec applications will be reloaded
automatically. One can deselect loading the minispec application after program start via
switching off the option Load Application on Startup in the Welcome Box. You can also
switch on / off the Welcome Box by marking / unmarking the Welcome Box command in the
View menu.

The Large Font Result Box Command
The information in the Result Window can be displayed using two different font sizes.
Marking this entry you will choose the larger font.

The Diagnostics View Command
With this command a window is opened up which displays various information for diagnostic
purposes. These options are helpful for checking the instrument status, connections, and
commands. Different diagnostics are available, depending on the active window. The transfer
of the diagnostic information from the minispec to the PC, and the display in the Diagnostics
View needs time and system resources, thus this command can be used to regulate
performance as required.

Note: To ensure a failure-free operation use these options only for diagnostic purposes and
not in the background for standard measurements. Unmark Diagnostics View and all
diagnostic possibilities when they are not any longer required!

The Pulse Ram Diagnostics Command
This command is only available if the Editor Window is active. If you mark this command,
information is printed about the pulse pattern of the NMR pulse sequence into the
Diagnostics View.

The Connection, Commands and Suppress Status Diagnostics Commands
If Connection Diagnostics is marked, information will be printed about the connection
between the minispec software and the minispec connected. With Commands Diagnostics,
information will be printed about the data exchange into the Diagnostics View. Some status
information about the hardware is requested every second. These requests take also place if
the status has not changed during the last interval. For a clear and easy diagnostic it may be
useful to suppress the printing using the command Suppress Status Diagnostics.
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Some of the functions described might only be available in certain minispec.exe software
versions.

8.3.8 The Process Menu

The Process item is only displayed when a Signal Window is active. Different commands for
data processing are summarized in this pull-down menu:

Figure 8.15: The Process Pull-Down Menu

Within the context not all commands may be reasonable, in which case they will be grayed.
The following series of built-in signal processing features are available:

The Fit Command
This command is only available in connection with calibrations. You can fit your calibration
data and display the fit results (see Info Views, point 4).

The FFT, Magnitude, Power and Absolute Commands
A Fast Fourier Transform of measurement data will be performed using the FFT command. If
the NMR signal is observed in complex mode (real and imaginary part of the signal) the
Magnitude ([Re2+Im2]1/2) or the power spectrum can be calculated. From the real,
imaginary or complex data, the Absolute values can be calculated.

The Signal Flip, and the Signal Swap Command
The signal can be mirrored with respect to an offset frequency of 0 using the Signal Flip
command. The Signal Swap command exchanges the real and imaginary part.
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8.3.9 The Window Menu

Figure 8.16: The Window Pull-Down Menu

Default, Cascade, Tile Horizontal and Tile Vertical Commands
You can arrange the windows (see figure) as Cascade in an overlapping fashion, or you may
arrange multiple open windows Horizontally or Vertically side by side. To reset the window
alignment, use the Default command.
Shortcut Keys: ALT+W.

The Arrange Icons Command
Use this command to arrange the icons for minimized windows at the bottom of the main
window. If there is an open document window at the bottom of the main window, some or all
of the icons may not be visible because they are hidden behind this document window.

The Marker Command
This command sets the Marker Cursor on / off. Use the mouse or the cursor keys to position
the data cursor. Data point information (and the distance from the fitted value) is then
available in the Status Bar. The window is only active if a calibrated data file for the
application exists.
Shortcut Standard Tool Bar:

The 1, 2, 3,... Commands
Use the numbers or the mouse to select one of the listed windows at the bottom of the menu
to set it into the foreground.
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8.3.10 The Help Menu

For a user friendly handling the minispec software includes a detailed help function. You have
the choice of different entries to receive help on your questions (see figure). Green entries in
the help text are cross references to related topics. One may switch to them by clicking on
the green text.

Figure 8.17: The Help Pull-Down Menu

The Using Help Command
A help box will be activated with information on how to use the different help options.

The Help Topics Command
This command will open up a dialog box where the topics you want information about are
entered.

The About the minispec Command
Use this command to display the copyright notice and version number of your copy of the
minispec software.

Shortcuts: Standard Button Bar: 

Additional Help Functions
While moving the cursor through the buttons, a short on-line help will be displayed describing
the function of the button. At the same time a more detailed description is displayed in the left
part of the Status Bar.
If you want an expatiated comment about menu functions, windows, commands or buttons
use the Context Help command.

Shortcuts: Standard Button Bar: 
Keys: SHIFT+F1
When you select the Standard Toolbar's context help button, the mouse pointer will change to
an arrow and a question mark. Click somewhere in the minispec software window, for
example on another Toolbar button or a menu entry, to display the corresponding help topic.
You can also receive help about the current active window. If you want to open a window with
detailed information use the shortcut keys F1.
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9 Basic NMR Principles
NMR (Nuclear Magnetic Resonance)  is made possible by the properties possessed by some
atoms that cause their nuclei (part of every atom) to have a magnetic moment. The atom
most commonly investigated by NMR is hydrogen (1H), the nucleus of which is composed of
a single proton. Hydrogen is present in many natural and synthetic substances like oil, water,
polymers, pharmaceutics and foodstuffs. Another nuclei often investigated is fluorine, typical
applications include fluorine content in toothpaste or fluorine in chemical compounds.
In a strong external magnetic field (called polarizing field) produced by the permanent
magnets in the Magnet Unit, the magnetic moments can be oriented, and the vector sum of
all moments results in a macroscopic magnetization. The amount of magnetization depends
on the strength of the external magnetic field and the temperature.
Pulses of radio frequency (RF) at a suitable frequency can influence the magnetization in the
sample. In NMR this resonance frequency, called Larmor frequency, depends on the field
strength of the external magnetic field and the nucleus investigated. For example, at a field
strength of 0.47 Tesla, protons (1H) have a resonance frequency of 20 MHz. The orientation
of the magnetic field generated by the RF pulse is perpendicular to the static external
polarizing field.
When, for example, a sample containing NMR-active nuclei is exposed to a strong external
magnetic field by inserting a sample into the sample orifice of the magnet, the process of
buildup of macroscopic magnetization will start immediately, but it takes some time until the
equilibrium is reached. The time constant of this built-up process is called longitudinal
relaxation time T1 (see figure).

Figure 9.1: Increase of the NMR Signal Due to Longitudinal Relaxation

With skillful sequences of RF-pulses (generated by the minispec electronics and transmitted
to the sample via the probe) the macroscopic magnetization can be influenced. One
possibility is the generation of so-called transverse magnetization. This is not an equilibrium
state, and therefore different relaxation processes arise. The transverse magnetization is still
the vector sum of discrete atomic magnetic moments. Each one of these moments underlies
a specific time evolution, and a loss of phase coherence results. The time scale of this
magnetization loss is described by the transverse relaxation time T2 (see figure) in the easiest
case.
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Figure 9.2: Decay of the NMR Signal Due to Transverse Relaxation

Secondly, the system naturally tends to relax back to the thermal equilibrium. This process is
equivalent to the polarization process described above and takes place with the time constant
T1. Various other processes are known from NMR-theory, depending on the pulse sequences
used to manipulate the magnetization. These processes are described by different relaxation
times, some examples are T1ρ, T1D, and T2e.
Substances and materials can be characterized by relaxation measurements because the
relaxation times are highly sensitive to molecular properties. For example, they can be
sensors for various ranges of molecular motions. The large range of motions that can be
characterized by NMR is a main point which makes NMR to such a valuable tool in analysis.
For example, because of their different relaxation behavior solid and liquid parts in one
sample can be distinguished clearly and their amount determined as in Solid Fat Content
(SFC) measurements. As a consequence such materials as foodstuff, cosmetics, chemical
products and much more can be investigated. For a more detailed description refer to the
application descriptions available from Bruker.
Furthermore, the intensity of the NMR signal is a function of the number of atomic moments
contributing to the macroscopic magnetization. Therefore, the signal is a measure of the
number of nuclei in a sample. The minispec methods make use of this relationship to
determine the amount of, for example, oil or moisture in a wide range of samples.
In summary, NMR makes use of the nuclei in substances as sensors of their surroundings,
yielding important information about the matter. Since both excitation and detection are
performed via electromagnetic waves in the radio frequency region, this analytical method is
contactless, non-destructive, and rapid.
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10 Maintenance

10.1 Cleaning

Before Cleaning
Disconnect the mains cable from the unit before cleaning.

Cleaning the Main Unit
Use a clean damp cloth to wipe off any residue from the outside of the unit. Wipe off excess
moisture immediately with a dry cloth.
For non water soluble marks, wipe using a cloth with a few drops of isopropyl alcohol.

Before Reconnecting the Power Supply
Wait until the unit is completely dry before reconnecting the power supply!
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11 Dismantling and Disposal
Following the end of its operational life, the unit can be returned to Bruker for safe disposal. If
this is impractical, the unit should be disposed of safely as prescribed by local environmental
regulations.

Installation, initial commissioning, retrofitting, repairs, adjustments or dismantling of the
device must only be carried out by Bruker Service or personnel authorized by Bruker.
Damage due to servicing that is not authorized by Bruker is not covered by your warranty.

11.1 Dismantling

Before starting dismantling:
1. Shut down the device and secure to prevent restarting.
2. Physically disconnect the power supply from the device; discharge stored residual energy.
3. Remove consumables, auxiliary materials and other processing materials and dispose of

in accordance with the environmental regulations.
4. Clean assemblies and parts properly and dismantle in compliance with applicable local

occupational safety and environmental protection regulations.

11.2 Disposal
If no return or disposal agreement has been made, send the dismantled components for
recycling as prescribed by local environmental regulations.

• Scrap metals.
• Send plastic elements for recycling.
• Dispose of packaging material in accordance with the relevant applicable legal

requirements and local regulations.
• Sort and dispose of other components in accordance with their material composition.

NOTICE
Danger to the environment from incorrect handling of pollutants!
Incorrect handling of pollutants, particularly incorrect waste disposal, may cause serious
damage to the environment.
u Always observe local environmental regulations regarding handling and disposal of

pollutants.
u Take the appropriate actions immediately if pollutants escape accidentally into the

environment. If in doubt, inform the responsible municipal authorities about the damage
and ask about the appropriate actions to be taken.
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12 Contact
Manufacturer:

Bruker BioSpin GmbH
Am Silberstreifen
D-76287 Rheinstetten
Germany
Helpdesk Europe: (+49) 721-5161-6155
Helpdesk USA: (+1) 978-667-9580
E-Mail: minispec.SLS@bruker.com
http://www.bruker.com
WEEE DE43181702

Bruker BioSpin Hotlines
Contact our Bruker BioSpin service centers.
Bruker BioSpin provides dedicated hotlines and service centers, so that our specialists can
respond as quickly as possible to all your service requests, applications questions, software
or technical needs.
Please select the service center or hotline you wish to contact from our list available at:
http://www.bruker.com/service/information-communication/helpdesk/magnetic-
resonance.html

mailto:minispec.SLS@bruker.com
http://www.bruker.com
http://www.bruker.com/service/information-communication/helpdesk/magnetic-resonance.html
http://www.bruker.com/service/information-communication/helpdesk/magnetic-resonance.html
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